NASDAQ Opening and Closing Crosses and the Net Order Imbalance Indicator (NOII) Guide

Access Through the NASDAQ Workstation and Select Service Bureaus
One of the primary benefits of the NASDAQ Opening and Closing Crosses is the detailed information disseminated about opening and closing orders and likely clearing prices. NASDAQ disseminates Net Order Imbalance information for the Opening Cross from 9:28 a.m. to 9:30 a.m., Eastern Time (ET), and for the Closing Cross from 3:50 p.m. to 4:00 p.m., ET. This information is intended to inform all market participants equally and to minimize surprises at the market open and the market close. This guide provides instructions on how to access imbalance information and how to place orders in the Opening and Closing Crosses through the NASDAQ Workstation as well as through select service bureaus.

Terminology .................................................. 2
NASDAQ Workstation ..................................... 4
Bloomberg ..................................................... 8
Fidessa .......................................................... 12
Lava ............................................................. 14

Renaissance .................................................. 17

SunGard ........................................................ 18
Brass ............................................................. 18
U2 ............................................................... 19
UMA ........................................................... 21

Townsend Analytics ...................................... 23
RealTick ....................................................... 23
**Terminology**

**Paired Shares:** The number of eligible shares able to be matched at the current reference price.

**Imbalance Shares:** The number of eligible shares that would remain unexecuted at the current reference price.

**Imbalance Side:** The side of the imbalance: $B = $ buy-side imbalance; $S = $ sell-side imbalance; $N = $ no imbalance; $O = $ no marketable on-open or on-close orders in NASDAQ.

**Current Reference Price:** The reference price upon which the paired shares and the imbalance quantity are based. The price is calculated at or within the NASDAQ Inside™.

**Near Indicative Clearing Price:** The clearing price at which the opening or closing book would clear against orders in both the opening or closing book and the continuous book.

**Far Indicative Clearing Price:** The clearing price at which the opening or closing book would clear against orders only in the opening or closing book.

**Price Variance Indicator:** The percentage of how far the near indicative clearing price is from the current reference price by calculating the absolute value of the percentage of deviation of the near indicative clearing price to the current reference price.

The associated values are:

- **L:** Less than 1%
- **1:** 1%
- **8:** 8%
- **2:** 2%
- **9:** 9%
- **3:** 3%
- **A:** 10% to 19.99%
- **4:** 4%
- **B:** 20% to 29.99%
- **5:** 5%
- **C or Space:** 30% or greater or cannot be calculated
- **6:** 6%
- **7:** 7%

**Clearing Indicator:** There is buy or sell interest that cannot be paired at either the near or far indicative clearing prices. Values can be: Market Buy, Market Sell or blank, which indicates an indicative price is present.
OPENING AND CLOSING ORDER TYPES

Several of the service bureaus that provide connectivity to NASDAQ also provide a facility for entering orders into NASDAQ’s Opening and Closing Crosses. The order types that can be entered include:

**On-Open (OO) Orders:** Order type executable only during the Opening Cross. Accepted and stored electronically, these orders will execute first at the open. May be entered at the market (market-on-open [MOO] order) or priced (limit-on-open [LOO] order).

**On-Close (OC) Orders:** Order type executable only during the Closing Cross. Accepted and stored electronically, these orders will execute first at the close. May be entered at the market (market-on-close [MOC] order) or priced (limit-on-close [LOC] order).

**Imbalance-Only (IO) Orders:** Order type executable only during the Opening and Closing Crosses. Accepted and stored electronically, these are liquidity-providing orders intend to offset on-open or on-close orders during the cross.
QUICK ORDER ENTRY

To enter on-open and on-close orders:

1. Access the Quick Entry window in one of the following ways:
   • Select Quick Entry from the row of configurable buttons at the top of the Dynamic Quote window.
   • Press the Alt and Q keys while on any window in the NASDAQ Workstation

2. Enter your order in the Quick Entry window (shown below). Click the Legend icon to get message formats, modifiers and prefixes.

   For market-on-open or market-on-close orders:
   • Enter “=” or “mkt” as the price.
   • Enter “.H” for open or “.C” for on-close as the TIF (Time-In-Force).
     Example: B1000PETM=.C

   For limit-on-open or limit-on-close orders:
   • Enter a limit price.
   • Enter “.H” for on-open or “.C” for on-close as the TIF.
     Example: B1000PETM31.01.H

   For imbalance-only orders:
   • Enter a limit price.
   • Enter “.H” for on-open or “.C” for on-close as the TIF.
   • Enter “.M” to designate the priority as imbalance-only.
     Example: B1000PETM31.01.C.M

3. Click the Send button to send the order to NASDAQ.
ORDER ENTRY (SHORT OR LONG FORM)

To enter on-open or on-close orders:

1. Access the Order Entry form in one of the following ways:
   - Select Order Entry from the row of configurable buttons at the top of the Dynamic Quote window.
   - From the Weblink Manager window, select the Trader Tab and click on the Order Entry button.
   - From the Dynamic Quote window, use the Order Entry short form at the bottom of the window (shown below).

2. Enter your order in the Order Entry box (shown below):
   - For market-on-open or market-on-close orders:
     - Enter “=” or “mkt” as the price.
     - Leave Priority field blank.
     - Select OO for on-open or OC for on-close from the TIF drop-down menu.
   - For limit-on-open orders:
     - Enter a limit Price.
     - Leave Priority field blank.
     - Select OO for on-open or OC for on-close from the TIF drop-down menu.
   - For imbalance-only orders:
     - Enter a limit Price.
     - Select Imbalance Only as the Priority.
     - Select OO for on-open or OC for on-close from the TIF drop-down menu.

3. For all order types, enter a quantity.

4. Click the Send button to send the order to NASDAQ.
TO ACCESS IMBALANCE INFORMATION:

1. From the Dynamic Quote window, click on the NOII command button at the top of the window (shown below). Please note: In order to access NOII from the NASDAQ Workstation, click on Admins and Settings, and set NOII as one of the configurable command buttons.

**Dynamic Quote Window**

To view imbalance information for a specific security:

- Enter the security’s symbol in the entry box, and click Go (shown below).

**NOII Entry Box**
To create and view a portfolio of securities (shown below):

- Type the securities’ symbols in the entry box separated by commas.
- Click on **Save Portfolio**.

![Portfolio of Securities displayed in the NOII](image)

To view a saved portfolio:

- Click on **View Saved Portfolio**.

**FOR MORE INFORMATION, CONTACT NASDAQ TRADING OPERATIONS AT 800.291.4861.**
TO ENTER ON-OPEN AND ON-CLOSE ORDERS:

1. On the NQMS window, click on the Bid or Ask column of the market depth.
   The Bloomberg Total Access (BTA) Ticket will overlay the screen (shown on page 9).

2. Click on the Instruction drop-down menu.

3. For on-open or on-close orders:
   • Select OPG for on-open or CLO for on-close from the Instruction drop-down menu.
     - If the price equals MKT, a market-on-open or market-on-close order will be sent.
     - If there is a limit price on the order, a limit-on-open or limit-on-close will be sent.

4. For imbalance-only orders:
   • Select IO from the Instruction drop-down menu.
   • Enter a price in the Price field.

5. For all order types, enter a quantity.

6. Click the green GO button to send the order to NASDAQ.
Bloomberg Total Access (BTA) Ticket

For more information, contact Jim Vassak at 212.617.6664.
TO ACCESS IMBALANCE INFORMATION:
Enter “<ticker symbol> UQ Equity QRM NETMB”. The imbalance information can also be accessed in the QR or QRM screen under QR/QRM Options by selecting Net Imbalance Only-NETIMB or Net Imbalance Included-NETINC.

HOW TO INTERPRET THE DATA DISPLAY:
In the screen shown on page 11, Bloomberg displays imbalance information in rows 1 through 4.

Far Indicative Clearing Price: “FI” — In this example, it is $24.47.

Near Indicative Price: “NI” — In this example, it is $24.68.

Current Reference Price: “OI” — The size in this OI row is the amount of the imbalance in round lots. If shown on the bid side, it reflects a buy-side imbalance, and if shown on the ask side, it reflects a sell-side imbalance. (Price is shown in the bid for a buy-side imbalance and in the ask for a sell-side imbalance.) In this example, the current reference price is $24.72 with a buy imbalance of 38,960.

Paired Shares: “CM” — The size in the CM row is the amount of paired shares in round lots. In this example, it is 173,330. Please note: The CM row repeats the current reference price.
### Bloomberg Display of Opening Imbalance Data for JNPR

<table>
<thead>
<tr>
<th>Time</th>
<th>E</th>
<th>Bid/Trd/Ask</th>
<th>E</th>
<th>Size</th>
<th>MMkr</th>
<th>Cond</th>
</tr>
</thead>
<tbody>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.68</td>
<td>Q</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.47</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>/24.72</td>
<td>0 24.96</td>
<td>/01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.72</td>
<td>CM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.666</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>/24.71</td>
<td>0 38.96</td>
<td>/01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.71</td>
<td>CM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.666</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>/24.70</td>
<td>0 38.96</td>
<td>/01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.71</td>
<td>CM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.666</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>/24.71</td>
<td>0 38.96</td>
<td>/01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.71</td>
<td>CM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.666</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>/24.70</td>
<td>0 38.96</td>
<td>/01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.71</td>
<td>CM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.666</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>/24.71</td>
<td>0 38.96</td>
<td>/01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.71</td>
<td>CM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:28:59</td>
<td>Q</td>
<td>24.666</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Near Indicative Clearing Price**

**Far Indicative Clearing Price**

**Order Imbalance Size and Side** (Shown as buy-side)

**Number of Paired Shares** (In round lots)

**Current Reference Price** (Repeated two times)

---

FOR MORE INFORMATION, CONTACT MATT BASTIAN AT 609.279.4015.
TO ENTER ON-OPEN OR ON-CLOSE ORDERS:

Fidessa uses a single dialog box to support entry of on-open and on-close orders. The dialog box creates on-open orders when used prior to market open and creates on-close orders for the rest of the day.

Please note: NASDAQ does not accept on-close orders prior to market open.

1. Access the On-Open/On-Close dialog box (shown below) in one of the following ways:
   - Use the Open/Close Buy or Open/Close Sell buttons on the Market Depth window.
   - Use the right-click menus on the Market Depth or the Stock Monitor.
   - Use the right-click menus on the Open/Close Monitor (shown on page 13).

2. Enter the order details:
   - For all orders, enter a quantity.
   - For limit orders, specify a price.
   - For market orders, enter “A” (Any) in the Price field.
   - To enter a normal on-open or on-close order, set the Imb Only field to No.
   - To enter an imbalance-only order, set the Imb Only field to Yes.

The Auto option for the Imb Only field always defaults to No, which sends a normal on-open or on-close order to NASDAQ (i.e., not an imbalance-only order), except for on-close orders sent after 3:50 p.m., ET. After 3:50, NASDAQ accepts only imbalance-only on-close orders, so the Auto option sets to Yes.

3. Click the Send button to send the order to NASDAQ.

![Fidessa On-Open/On-Close Order Dialog Box showing DELL Sell Limit-On-Open Order](image)
TO ACCESS IMBALANCE INFORMATION:

1. Go to the NASDAQ tab on the Fidessa navigator bar, and launch the Open/Close Monitor (shown below).
   - This grid displays Opening Cross imbalance data from 9:28 to 9:30 a.m., ET. Then, it resets and displays Closing Cross imbalance data from 3:50 to 4:00 p.m., ET.
   - The data displayed in the Open/Close Monitor can also be added to the normal Stock Monitor and/or the Market Depth via the View Builder.
   - Additional imbalance-related fields not shown here may also be added via the View Builder.

FOR MORE INFORMATION, CONTACT FIDESSA SUPPORT AT 212.520.3619.
TO ENTER ON-OPEN OR ON-CLOSE ORDERS:

1. In the Order Launcher window (shown below), select NNMS from the Route menu.

2. For on-open or on-close orders:
   - Select Limit Order or Market Order from the Type drop-down menu.
   - For imbalance-only orders:
     - Select Limit Order from the Type drop-down menu.
     - Click the More button, and select Imbalance Only from the Execution Instruction drop-down menu.

3. Enter a quantity, and select OPG for opening orders or CLO for closing orders from the TIF drop-down menu.

4. Enter a price for limit-on-open, limit-on-close or imbalance-only orders.

5. Click the B (Buy) or S (Sell) button to send the order to NASDAQ.

Lava Order Launcher Window showing MSFT Buy Limit-On-Open Order
TO ACCESS IMBALANCE INFORMATION:

1. From the Lava Main Window, select Imbalance from the Window menu (shown below).

The Imbalance Window can be used to view the NASDAQ Opening and Closing Crosses and other market data. Multiple Imbalance Windows may be opened simultaneously, and each may be configured to display different symbols.

2. Right-click in the Imbalance window (shown below), and select one of the following options:
   - **Delete** — delete the Imbalance Window
   - **Configure** — display the configuration log
   - **Copy to Clipboard** — copy the data displayed to the clipboard
3. Available fields in the Imbalance Window

<table>
<thead>
<tr>
<th>Imbalance Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol</td>
<td>The four- or five-character identifier of the security</td>
</tr>
<tr>
<td>Inside Bid</td>
<td>National Inside Bid</td>
</tr>
<tr>
<td>Inside Ask</td>
<td>Last — National Inside Ask</td>
</tr>
<tr>
<td>Imbalance</td>
<td>The absolute difference between the number of shares in on-open or on-close and offsetting imbalance-only orders on the buy-side and the number of shares in on-open or on-close and offsetting imbalance-only orders on the sell-side at the Current Reference Price. The number of Imbalance Shares is never negative; however, this field will display a zero under certain circumstances.</td>
</tr>
<tr>
<td>Side</td>
<td>The Imbalance Side field indicates the market side of the imbalance. B = Buy-Side Imbalance, S = Sell-Side Imbalance, N = No Imbalance, O = No marketable on-open or on-close orders in NASDAQ, thus no imbalance.</td>
</tr>
<tr>
<td>Reference Price</td>
<td>NASDAQ inside price that corresponds to the matched shares and imbalance</td>
</tr>
<tr>
<td>Near Price</td>
<td>Indicates the price level at which the on-open or on-close and offsetting imbalances-only orders match against themselves and the NASDAQ continuous book</td>
</tr>
<tr>
<td>Far Price</td>
<td>Indicates the price level at which buy orders and sell orders match in the closing book</td>
</tr>
<tr>
<td>Paired Shares</td>
<td>The number of shares paired reflects the total number of shares entered for on-open or on-close and imbalance—only orders that are eligible to be matched at the Current Reference Price</td>
</tr>
<tr>
<td>Price Variance</td>
<td>Indicates the % difference between the Near Price and the price where the market is currently trading. A high value indicates there will be a large price difference between the Opening (or Closing) Cross price and the continuous market if sufficient offsetting interest is not entered.</td>
</tr>
<tr>
<td>Open</td>
<td>Current day’s opening price</td>
</tr>
<tr>
<td>Auction Service</td>
<td>Utilized Field is used for Lava support purposes</td>
</tr>
<tr>
<td>Auction Source</td>
<td>The four-character MPID or the exchange mnemonic</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Imbalance Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auction Type</td>
<td>Field indicating the type of imbalance: • Open — Opening Imbalance • Close — Closing Imbalance • Mkt — Market Imbalance • Halt — Halt (ARCA only)</td>
</tr>
<tr>
<td>Change</td>
<td>The change in the stock’s price relative to the previous day’s closing price</td>
</tr>
<tr>
<td>Close</td>
<td>Previous day’s 4:00 p.m., ET, closing price</td>
</tr>
<tr>
<td>Far Imbalance</td>
<td>The number of shares of Market-On-Close orders only that would be left unexecuted if closing indicative match volume were currently executed</td>
</tr>
<tr>
<td>Far Imbalance Side</td>
<td>A negative Far Imbalance indicates a sell imbalance and a positive Far Imbalance indicates a buy imbalance. High — Current day’s high trade</td>
</tr>
<tr>
<td>Inside Ask Size</td>
<td>Total shares shown at the inside ask, in round lots</td>
</tr>
<tr>
<td>Inside Bid Size</td>
<td>Total shares shown at the inside bid, in round lots</td>
</tr>
<tr>
<td>Low</td>
<td>Current day’s low trade.</td>
</tr>
<tr>
<td>No Auction Price</td>
<td>Indicates when the MOO or MOC orders cannot be fully paired against offsetting orders at either the Far Indicative Clearing Price or both the Near and Far Indicative Clearing Prices.</td>
</tr>
<tr>
<td>Pct Change</td>
<td>The percent change in the stock’s price relative to the previous day’s closing price</td>
</tr>
<tr>
<td>Tick</td>
<td>For NASDAQ stocks, this is the bid tick (last trade versus inside bid).</td>
</tr>
<tr>
<td>Today’s Close</td>
<td>Today’s 4:00 p.m., ET, closing price</td>
</tr>
<tr>
<td>Volume</td>
<td>Number of shares of the stock traded so far during the current day.</td>
</tr>
<tr>
<td>Volume in 1000s</td>
<td>Number of shares of the stock traded so far during the current day in 1000s. (i.e., 78,000 = 78)</td>
</tr>
</tbody>
</table>
TO ENTER ON-OPEN OR ON-CLOSE ORDERS:

1. In the Order Entry window (shown below), select the House radio button.
2. Populate the Side, Symbol and Quantity fields.

   For on-open or on-close orders:
   - Select Market On Open, Market On Close, Limit On Open or Limit On Close from the Order Type drop-down menu.
   - Populate the Price field if entering a limit-on-open or limit-on-close order.
   - In the Route To field, select SM from the Via drop-down menu.

   For imbalance-only orders:
   - Follow the same steps as for a limit-on-open or limit-on-close order above. Then, click the Details button (or hit the F7 key).
   - Under Montage Options, select Imbalance Only from the Priority drop-down menu.

3. Click the Send and Close button (or hit the F12 key) to send the order to NASDAQ.

FOR MORE INFORMATION, CONTACT RENAISSANCE SUPPORT AT 203.705.3371.
To enter on-open or on-close orders:

1. From the Order Browse window, select an order that has “OPN” or “CLO” in the Instruction field or that you want to send to the Opening or Closing Cross. Click the Send To External action button.

   For on-open or on-close orders:
   
   - Enter “SUMO” in the Destination field, or choose SUMO from the routing destination options.
   - Enter “OPN” for on-open or “CLO” for on-close in the Instruction field, or choose OPN or CLO from the order instruction options.
   - Enter “MKT” in the Price field for a market-on-open or market-on-close order, or enter a price for a limit-on-open or limit-on-close order.

   For imbalance-only orders:
   
   - Follow the same steps as for a limit-on-open or limit-on-close order above. Then, insert the letter “I” in the SM Exec Type field.

2. For all order types, enter a quantity.

3. Click the Xmit button to send the order to NASDAQ.
U2 VERSION 1.2 USERS

To enter on-open or on-close orders:

1. Select **SUMO** on the second drop-down window.

   For market-on-open or market-on-close orders:
   - Select **MARKET** from the third drop-down menu.
   - Select **OO** for on-open or **OC** for on-close from the **TIF** drop-down menu.

   For limit-on-open or limit-on-close orders:
   - Select **LIMIT** from the third drop-down menu.
   - Select **OO** for on-open or **OC** for on-close from the **TIF** drop-down menu.

   For imbalance-only (I/O) orders:
   - Select **LIMIT** from the third drop-down menu.
   - Select **OO** for on-open or **OC** for on-close from the **TIF** drop-down menu.
   - Change the **Method** to **IMBALANCE** (shown below).

2. For limit-on-open, limit-on-close and imbalance-only orders, enter a **price**.

3. For all order types, enter a **quantity**.

4. Click the **Submit** button to send the order to NASDAQ.

![U2 Universal Order Ticket showing ZVZZT Opening Buy Imbalance-Only Order](image-url)
TO ACCESS IMBALANCE INFORMATION:

1. Click the icon on the desktop for the U2 Opening/Closing Cross application.
2. The Market Watch window will appear with all columns shown below.
3. Right click in the Market Watch settings, and choose symbols.
4. Enter the list of symbols you wish to view.
5. Click the OK button. The symbols will be loaded, and all of the Opening or Closing Cross information will be visible.

<table>
<thead>
<tr>
<th>Symbo</th>
<th>Paired</th>
<th>Imbalance</th>
<th>ImbSide</th>
<th>MatchPrice</th>
<th>NClnPrice</th>
<th>FClnPrice</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMZN</td>
<td>1768</td>
<td>0</td>
<td>N</td>
<td>41.17</td>
<td>41.17</td>
<td>41.17</td>
</tr>
<tr>
<td>CHRW</td>
<td>644</td>
<td>0</td>
<td>N</td>
<td>39.72</td>
<td>39.72</td>
<td>39.72</td>
</tr>
<tr>
<td>CSCO</td>
<td>16830</td>
<td>38493</td>
<td>S</td>
<td>21.63</td>
<td>21.57</td>
<td>21.56</td>
</tr>
<tr>
<td>DELL</td>
<td>12323</td>
<td>17777</td>
<td>B</td>
<td>34.635</td>
<td>34.64</td>
<td>34.68</td>
</tr>
<tr>
<td>INTC</td>
<td>26000</td>
<td>45</td>
<td>S</td>
<td>27.55</td>
<td>27.55</td>
<td>27.5</td>
</tr>
<tr>
<td>LAMR</td>
<td>0</td>
<td>100</td>
<td>B</td>
<td>39.975</td>
<td>40.03</td>
<td>40.09</td>
</tr>
<tr>
<td>LNCR</td>
<td>0</td>
<td>1001</td>
<td>S</td>
<td>34.455</td>
<td>34.41</td>
<td>34.39</td>
</tr>
<tr>
<td>LVLT</td>
<td>638</td>
<td>3111</td>
<td>B</td>
<td>3.3</td>
<td>3.31</td>
<td>0</td>
</tr>
<tr>
<td>MSFT</td>
<td>24500</td>
<td>49605</td>
<td>S</td>
<td>25.895</td>
<td>25.87</td>
<td>0</td>
</tr>
<tr>
<td>PETM</td>
<td>2272</td>
<td>19</td>
<td>S</td>
<td>29.18</td>
<td>29.18</td>
<td>29.17</td>
</tr>
<tr>
<td>PIXR</td>
<td>500</td>
<td>100</td>
<td>S</td>
<td>64.97</td>
<td>64.97</td>
<td>64.96</td>
</tr>
<tr>
<td>ROST</td>
<td>600</td>
<td>400</td>
<td>B</td>
<td>24.785</td>
<td>24.85</td>
<td>24.9</td>
</tr>
<tr>
<td>VRSN</td>
<td>1110</td>
<td>2492</td>
<td>B</td>
<td>17.75</td>
<td>17.81</td>
<td>17.83</td>
</tr>
<tr>
<td>YHOO</td>
<td>7900</td>
<td>0</td>
<td>N</td>
<td>28.67</td>
<td>28.67</td>
<td>28.67</td>
</tr>
<tr>
<td>ZVZZT</td>
<td>100</td>
<td>0</td>
<td>N</td>
<td>112.685</td>
<td>112.69</td>
<td>112.685</td>
</tr>
</tbody>
</table>

U2 Market Watch Window showing Closing Imbalance Data for a Portfolio of Securities
UMA 3.2 USERS

To enter on-open or on-close orders:

In order to have a pre-defined Order Detail Ticket (shown bottom right) with the NASDAQ Opening or Closing Cross, quick action buttons will need to be created.

To set up a quick-action button:

1. Right-click in the Market Maker window, and select Setup.
2. Click on the Quick Action Setup window (shown top right).
3. Select Initiate Inside Buy or Initiate Inside Sell from the Action Type drop-down menu.
4. Select Sumo from the Destination drop-down menu.
5. Click the Popup Confirm button.
6. Click the OK button in the Quick Action Setup window.
7. In the Market Maker window, click the quick action button you just created.
8. In the Order Detail Ticket that pops up:
   - Enter a price and quantity.
   - Select one of the following from the Auction drop-down menu:
     - MOO for a market-on-open order
     - MOC for a market-on-close order
     - LOO for a limit-on-open order
     - LOC for a limit-on-close order
     - Imb.Open for an opening imbalance-only order
     - Imb.Close for a closing imbalance-only order
   - Click the OK button to send the order to NASDAQ.

The following order-entry components accept Opening and Closing Cross orders in UMA:

- Order Dialog with the Market Maker
- Order Dialog with the Monitor
- Order Entry window
- Quick Entry line
- Quick Action Hit and Take buttons
TO ACCESS IMBALANCE INFORMATION:

1. Select **Options** from the **Windows** menu.
2. Choose **Create Popup Window**.
3. Select **Market Watch** as your window.
4. Right click in the **Market Watch** window (shown below), and choose **Setup**.
5. Click on the **Symbols** tab, select your own trading number, and the symbols will be pre-populated.
6. Click on the **Alerts** tab and select **Paired Shares, Imbalance Shares, Imbalance Side, Reference Price, Near Clearing Price** and **Far Clearing Price**.
7. Click the **OK** button. The symbols will be loaded, and all the Opening or Closing Cross information will be visible.

**FOR MORE INFORMATION, CONTACT SUNGARD SUPPORT DESK AT 201.499.5910.**
TO ACCESS IMBALANCE INFORMATION:

1. From the RealTick MarketMinder™ window, right-click on the Minder, and select Column Layout Choices — Configure Column Layout.
2. Under Available Fields, click on LIVEQUOTE, and choose data fields from the <All Fields> and <Stocks> sub-categories to configure your imbalance layout (shown below).

![Configure Column Layout](image)

3. Click OK to view the layout in MarketMinder (shown below).

![MarketMinder Layout](image)
TO ACCESS IMBALANCE NEWS ALERTS:

1. From the News window, right-click on the window, and select Quick Search.

2. Enter “IMBA” as the Filter (shown below).

   ![Quick Search Criteria](image)

3. Click OK to view the News Alerts (shown below).

   Imbalance alerts appear as headlines with security, type (Buy or Sell) and number of shares.

   ![100 Headlines: IMBALANCE](image)

FOR MORE INFORMATION, CONTACT REALTICK SUPPORT AT 800.997.9630.